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Technical Support Contact Information

Clinic Team Members - If you are experiencing difficulties using any of the AIM tools (e.qg. initial installation,
setup and day to day use) it is highly recommended that you consult the table of contents of the appropriate
user guide for support before contacting your assigned facilitator.

Facilitators - Similar to clinic users, facilitators should consult the table of contents of the appropriate user
guide for support before contacting their Regional Support Team member when experiencing difficulties using
any of the AIM tools. If you do not know who your Regional Support Team member is or your region is
currently without one, please contact the AIM Measurement Support Team at the email address below.

Faculty Members - Faculty members should consult the table of contents of the appropriate user guide for
support before contacting the AIM Measurement Support Team at the email address below.

Regional Support Team Members - Regional Support Team members should direct their technical issues to
the AIM Measurement Support Team at:

measurement@albertaaim.ca

(Kylie Kidd Wagner or Randy Campbell)

Please NOTE:

e To help us troubleshoot your issue better, please provide a detailed description of the problem(s) in
your email

e Emails received by the AIM Measurement Support Team will, in general, be responded to in the order in
which they are received

e Requestors should expect a response to their issue(s) within one week

¢ In the event that a solution to an issue requires greater exploration by the AIM Measurement Support
Team, the response will inform the requestor of those details

e All users should check the Alberta AIM Website periodically to ensure they have the most recently
updated copy of the appropriate user guide(s) - http://www.albertaaim.ca/measurment.html
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Octane — Quick Reference

Octane is a Specialty measure that focuses on the richness of the appointment mixture — i.e. ratio of “new”
patient appointments to “total” patient appointments.

Octane = New Appointments
(New Appointments + Return Appointments)

Initial Installation - Please refer to the appropriate section below for more details if required

1. Save the Octane.xls file to the same location as your AlIMTracking.xIs file (i.e. your AIM folder located on your

C:\drive)
2. Ensure the Octane.xls file is named to “Octane.xIs” exactly

Ensure your Excel security settings are appropriate (refer to the appropriate section below based on the version of
Microsoft Excel you are using for more details)

Populating the Octane File - Please refer to the appropriate section below for more details if required
Take the following steps to download data from your AIMTracking.xls file into the Octane.xls file:
1. Ensure the Octane.xls file is named “Octane.xIs” exactly

2. Ensure the AIMTracking.xls file of interest and the Octane.xls file are save to the same location (e.g. M)

3. Open both files
4. Inthe AIMTracking.xls file press Alt+F8

5. In the Macro window that appears select the Octane.xIs!Data2Octane program

Macro name:
Octane. s Data2Ockane Rz l
Cleanlp ~

ComeTolew F St

Octane. xls|DataZickane
DownloadaIMData

Hide_Teamwork_Tab
HideGenericl
HideGeneric W

HideGeneric3

HideInkro

HideserviceCycleData

Ockane. xls|HideServiceCvcleData

PopulatelextSetup v

Macros in: | All Open Workbooks v

Descripkion

Cancel

6. Press the Run button

7. The screens will flash while the program is running — once finished the Octane.xls file should be populated



Initial Installation

1. Save the Octane.xls file to the same location as your AIMTracking.xIs file (i.e. your AIM folder located
on your C:\drive)

2. Ensure the Octane.xls file is named to “Octane.xIs” exactly.

3. Ensure your Excel security settings are appropriate (refer to the appropriate section below based on the
version of Microsoft Excel you are using for more details)

Microsoft Excel 1997 to 2003 Users

Option 1 - Your Security Settings Do Not Need to be Changed

- If you receive the following pop-up message when opening the Octane.xls file your security settings
do not need to be changed. They are already set to “Medium”.

- “Medium” Security means you will receive this same warning each time you open the Octane.xls
file.

- Similar to the other AIM tools, for the file to function properly always click Enable Macros for the
Octane.xls file.

NOTE: For any other file (i.e. non AIM files) from an unknown or un-trusted source, click Disable
Macros.

Security Warning ==

"COAIMYOctane. xls”™ contains macros.,

Macros may contain viruses, Itis usually safe to disable macros, but if the
macros are legitimate, you might lose some functionality.

Disable Macros ] [ Enable Macros ] [ More Info




Option 2 - Your Security Settings Need to be Changed

- If you receive the following pop-up message when opening the Octane.xls file the security settings
in your Microsoft Office Excel need to be changed. They should be set to “Medium”.

Microsoft Excel ==

Macros are disabled because the security level is set to High and a digitally signed Trusted Certificate is not
attached to the macros. To run the macros, change the security level to a lower setting {not recommended), or
request the macros be signed by the author using a certificate issued by a Certificate Authority.

= [ Hide Help == I I Open in Help Window

You may encounter this error for the following reasons:

1. Macro security is set to:
»  Very High and the application encounters a signed macro, but the macro was automatically disabled,
Use the following procedure to enable the macro:
L 1, Select the Tools menu option and then select Macre and Security. In the resulting Security
dialog, set the security level to High by dicking the High radio button,
| 2. Close the file and any other instances of the application currently running on the computer (dlose
all applications that also use the application yvou are currently running). i

= = Fimam Hum fla m;zi; 2;d svsmime Heie martifieoste af froct Aatsile 2md cat Heae Aharaurs Fenck

To check on your settings, or to change them, follow these steps:

1
2
3.
4
5

o

Open the Octane.xls file

Under the Tools menu, click Options

Click the Security tab

Under Macro Security, click Macro Security

Click the Security Level tab, and then select the security level you want to use. (Choose
Medium)

Close the file (save your changes)
Reopen the Octane.xls file and the new security level should be in effect

NOTE: once you change your security settings, they are changed for Microsoft Office Excel, not just for
the Octane.xls file. They will stay on “Medium” until set to another level.

Taking the steps above will cause Microsoft Office Excel to present you with the Security Warning
message (below) each time you open the Octane.xls file. Always click “Enable Macros” for the
Octane.xIs file. For any other file (i.e. non AIM files) from an unknown or un-trusted source, click
“Disable Macros”.

Security Warning (3]

"C\AIMYOctane, xls™ contains macros.

Macros may contain viruses, It is usually safe to disable macros, butif the
macros are legitimate, you might lose some functionality.

Disahle Macros I I Enable Macros I I Maore Info




Microsoft Excel 2007 Users

Unlike older versions of Microsoft Office Excel, those using Excel 2007 will need to create a Trusted
Location in order for the Octane.xls file to function properly.

What is a Trusted Location? A trusted location is typically a folder on your hard drive (C:\ drive) or a
network share. Any file placed in a trusted location can be opened and will be allowed to run without
being checked by the Trust Center security system. As the Octane.xls file comes from a trusted source,
allowing it to run without a security scan is safe. If you see the following Security Warning message
below the Ribbons when you open your Octane.xls file this message means a Trusted Location needs
to be created for the file.

x| IR a% s
‘iﬂ/'
— Home Insert Page Layout Formulas Data
Cut —
é Cu Arial NIRRT =
=3 Copy
Paste R | =
- # Format Painter B4 U = =
Clipboard (] Font
@ Security Warning Macros have been disabled. Options..,

To create your Trusted Location follow these steps":

1.

a > 0D

o

10.
11.

Open the Octane.xls file

{ Ca

Click the Microsoft Office Button “** , and then click Excel Options
Click Trust Center and then Trust Center Settings

Click Trusted Locations

If you want to create a Trusted Location that is not local to your computer (i.e. not on your C:\
Drive), select the Allow trusted locations on my network (not recommended) check box

Click Add new location

In the Path box, type the name of the folder that you want to use as a Trusted Location, or click
Browse to locate the folder (e.g. the AIM folder you installed onto your C:\ Drive)

If you want to include subfolders as trusted locations, select the Subfolders of this location
are also trusted check box

In the Description box, type what you want to describe the purpose of the trusted location
(OPTIONAL)

Click OK (three times)

Save the file. Close and reopen it. You should no longer receive the “Security Warning —
Macros Have Been Disabled” prompt

Important Consideration When Creating Your Trusted Location - We strongly recommend
that you do NOT make a location common to all computers (e.g. your entire C:\ Drive, your
Desktop or your My Documents folder) a Trusted Location. Doing so will put you at a security
risk (e.g. make you vulnerable to viruses).




Microsoft Excel 2010 Users

Unlike older versions of Microsoft Office Excel, those using Excel 2010 will need to create a Trusted
Location in order for the Octane.xls file to function properly.

What is a Trusted Location? A trusted location is typically a folder on your hard drive (C:\ drive) or a
network share. Any file placed in a trusted location can be opened and will be allowed to run without
being checked by the Trust Center security system. As the Octane.xls file comes from a trusted source,
allowing it to run without a security scan is safe. If you see the following Security Warning message
below the Ribbons when you open your Octane.xls file this message means a Trusted Location needs
to be created for the file.

= F = P ——
]| = = Ea
m Home Insert Page Layout Formulas Data Re
! Cut =
= & Cu Arial 10 A ==
=3 Copy ~ o
Paste B 7 U ==

= # Format Painter = =

Clipboard Font

(! Security Warning  Macros have been disabled. Enable Content

To create your Trusted Location follow these steps':

a b 0 Dh e

10.
11.

Open the Octane.xls file

Click the File Menu, and then select Options

Click Trust Center and then Trust Center Settings
Click Trusted Locations

If you want to create a Trusted Location that is not local to your computer (i.e. not on your C:\
Drive), select the Allow trusted locations on my network (not recommended) check box

Click Add new location

In the Path box, type the name of the folder that you want to use as a Trusted Location, or click
Browse to locate the folder (e.g. the AIM folder you installed onto your C:\ Drive)

If you want to include subfolders as trusted locations, select the Subfolders of this location are
also trusted check box

In the Description box, type what you want to describe the purpose of the trusted location
(OPTIONAL)

Click OK (three times)

Save the file. Close and reopen it. You should no longer receive the “Security Warning —
Macros Have Been Disabled” prompt

Important Consideration When Creating Your Trusted Location - We strongly recommend
that you do NOT make a location common to all computers (e.g. your entire C:\ Drive, your
Desktop or your My Documents folder) a Trusted Location. Doing so will put you at a security
risk (e.g. make you vulnerable to viruses).




Populating the Octane File

IMPORTANT:

- The Octane.xls file can only be connected to one AIMTracking.xls file at a time

Take the following steps to download data from your AIMTracking.xIs file into the Octane.xls file:
1. Ensure the Octane.xls file is named “Octane.xIs” exactly

2. Ensure the AlMTracking.xlIs file of interest and the Octane.xls file are save to the same location (e.g.

[ CohaIm )

3. Open both files
4. In the AIMTracking.xls file press Alt+F8

5. In the Macro window that appears select the Octane.xIs!Data2Octane program

Macro name:

i

Qckane, xlsiDatazockane

nu

CleanUp
ComeToMew
Ockane, xls|DakazOckane

DownloadAIMData

Hide_Tearwork_Tab
HideGenericl
HideGenericz -

HideGenerics

HideIntro

HideServiceCycleData

CQctane, xlsHideServiceCycleData
PopulateMextSetup

[

“Farm nFo

| £

Macros in: | all Open Workbooks W

Descripkion

Cancel

6. Press the Run button

7. The screen will flash while the program is running — once finished the Octane.xls file should be
populated



Using the Octane File

Octane is a Specialty measure that focuses on the richness of the appointment mixture — i.e. ratio of “new”
patient appointments to “total” patient appointments.

Octane = Mew Appointments

(New Appointments + Return Appointments)

How to Reformat the Scaling on a Graph Axis

Each of the Octane.xls graphs can be customized. Most commonly, users may want to reformat the scaling on
the y-axes of multiple graphs for comparison.

Please use the set of instructions below specific to your version of Excel.

Microsoft Excel — Excel 1997 to 2003 Users

1. Select the graph you wish to change

2. Right click on the y-axis and choose the Format Axis option

EXAMPLE

MNew Activity Volume Totak

m
— |

4 f
|
Wl

01- 01- 01- 01- 01- 01-

Mar-  Apr-  May-  Jun-  Jul- Aug-
2010 2010 2010 2010 2010 2010

3. Under the Scale tab - type in your preferred values for the Minimum, Maximum and Major Unit parameters
(ensure the Auto box is not checked)
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Format Aas @

|Patberns| Scale I Font | Mumber IAIignment

Value (Y] axis scale

Auto

Minimum; u} L
Maimum: 16|

Maior unit: 2 n

Minor unit: 0.4

Category (X) axis B
Crosses at: n]

Display units: Mane E Show display units label on chart

[ Logarithmic scale

[ values in reverse order

[7] category (%) axis crosses at maximum value

[ OK ] [ Cancel

4. Click Ok —your changes should be visible

NOTE: if you'd like to change the scaling back to automatic, repeat steps 1 - 3 and check the Auto
alternative for each parameter under the Scale tab

Microsoft Excel — Excel 2007 and Newer Users

1. Select the graph you wish to change
2. Right click on the y-axis and choose the Format Axis option

EXAMPLE!
1s|
| Calibri €~ |10 ~ A D2,
BIS=EEA - EE==
nz2”
Delete

L &9 Resetto Match Style -
Fant...

nh Change Chart Type..

&l select Data.. L

New Activity Volume Totak
I

Add Minor Gridlines

Format Major Gridlines...
% Format Axis... h .
L
Q 2 ]
g .,'DN ¥

] D

]
LR A4

¥
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3. Under the Axis Options - select the Fixed alternative before typing in your preferred values for the
Minimum, Maximum and Major Unit parameters

Format Axis

| Axis Options | | Axis Options

Mumber Minimum: () Auto @ Fixed
Fil Maximum: () aute (8 Fixed
Line Color Major unit: () aute @ Fixed |2.0

Line Style Minar unit: (&) | Ofed 04 ]
Shadow [ values in reyggss order

3-D Format = ithmjfscale l:l

Alignment

jor tick mark type: | Mone

N

Minor tick mark type: | Mone
Axis labels: Mext to Axis |

Horizontal axis crosses:
@ Automatic

O Maximum axis value

Close

4. Click Close — your changes should be visible

NOTE: if you'd like to change the scaling back to automatic, repeat steps 1 and 2 and select the Auto
alternative for each scaling parameter under the Axis Options

How to Print a Graph

Selecting the Print function in Excel will print all the graphs in the current tab. To print a single graph, click on it
before selecting the print function.

Saving Your Changes

If you save changes, such as reformatting the scaling on an axis, they will continue to exist the next time you
open your Octane.xls file. Only save your changes if you want them to be permanent.

As the Octane.xls file does not hold any data (i.e. it is populated via a link to your AlMTracking.xls file)
replacing it with a fresh copy will not result in a loss of data. When your current copy of Octane.xls isn’t
functioning properly or it has lost too much automatic formatting start using a fresh copy.

' Steps directly from http://office.microsoft.com/en-us/excel/HA100319991033.aspx
" Steps directly from http://office.microsoft.com/en-us/excel/HA100319991033.aspx
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